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The bilingual extractor is a simple to use, but

efficient tool to generate automatically term

pairs from translated documents (TMX files)
A term pair consists of a source and target term
A term can consists of several words

These term pairs can be used to create a
new terminology or add new terminology to
an existing terminology database.
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The Extractor was developed by Heartsome
Europe GmbH and LNE International.

It Is available as
Single user version.
It is part of the Araya Server translation tools.
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Extract Terms

File -> Extract Bilingual Terminology from File
(Option: Open after extraction)

Check extracted terms
Mark correct translation as ,validated”

Export terms
Export validated terms ...
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Die Inztallation wor biextract-pf kann beginnen 1.0 pf

Ziel werzeichnis ;

| |c:\F'rugram Filez"Arava |[ Andermn

“ee 1306 MEB Werfligbarer Festplattenplatz
“ee 9097 KB Benctigter Festplattenplatz

Spoot Inztaller Sprache

Deutsch A

Spoon Inztaller

[ Abbrechen ] [ Wieiter > l

Installation goes into directory c:/Program Files/Araya . Itis
recommended not to change this as all initialization files map
towards this directory.
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Go to directory:
c:./Program Files/Araya

Start: BIEdit.exe
Or double click : %
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Based on a TMX file all possible relevant
term pairs are computed. This Is based on a
statistical approach which determines the
frequency of source and target terms.

TMX = XML Exchange format for translation
memory databases
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Extraction Is based on segments which are
stored in a TMX file.

A segment can either be a sentence or a
whole paragraph.

Formats in TMX files are ignored.
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Each found term pair is associated with a quality
measure.
2. column of the extraction table

Value Is betweenl,0 (highest probability that the term pair
IS a translation) and 0,5 (lowest probability that the term
pair is a translation)

Terms can be validated as correct translations.

Last column of table
Approved = checked = validated
Unapproved = not validated

Validated terms can be exported.

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH



- Heartsome Europe GmbH
EnTH www.heartsome.de

Select line with term extraction pair
Validate = approving using

a0 1A

Double click term pair Approve Term 20
. . H 14
Right mouse click 2 1

Remove validation mark using
a double or
right mouse click

Disapprove Term
27
52

unap...

27
29
130

29
30
130

Frizchenschlager
El Zalvadar
Sierra Leone

frizchenschlager
el salwador unap. ..
zierra leane unap. ..

Validated terms appear in green
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The extraction file has the following format
Encoding format is UTF-8!

nr;score;status;terml.LangCode;terml.wordGroup;term
Len;tefml1l.wFreq;term2.LangCode;term2.wordGro
Len;term2.wFreq;sentLinked

1.wordGroup
2.wordGroup

Example line

0; 1.0 ;approved,; ; DIN;1;15; ; DIN;1;15;11
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o Araya Bilingual Term Extractor 1.1

File ©ptiong Plugins  Help

Score

SL LS I Freq 1 Freq 2 Source Terms Target Terms alickation I L]
il 11 22 22 Hutthén hutthén UNEpRroy. .. =
23 1M 27 27 Wishy wishy URSpproy...
26 1M 26 26 Paulsen paulsen URSpproy...
26 1M 26 26 Villiers williers URSpproy...

1M a4 a4 i i URSpproy

" 47 47 Tt

20
23

"
"

22

99
20
23

Jarzembowski
hallar

=10

jarzembowsk
rnollar

ustica
seattle
hrinkhorst
unhcr
dary
oreja
linkcahr
tomlinson
equal

Table:
This window contains the
source and target pairs

found

UNSRRroy...
UNSRRroy...
UNSRRroy...
UNSRRroy...

30.07.2009
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Value

Statistical measure that the source and target term are translation of each
other (quality measure)

SL

Number of segments where both source and target term appear in.
Freq 1

Number of segment where source term appears in
Freq 2

Number of segment where target term appears in
Source term

The source term
Target term

The translation of the source term
Validation

Check box, for marking correct term pairs

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 13
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Open an extraction file

e
=8 Options Plugins Help /

Close File

Open Term Extraction File. T Close an extraction file
1 el 1 EA

Save an open extraction file

Save Term Extraction File...

Save All Terms into Term Extraction File. ..
Save Validated Terms into Term Extraction File. .. Save extraction file with a new name

Save Selected Terms into Term Extraction File,.. \X
N

Export Terms from Term Extraction File

Export Terms from Term Extraction File
Export Validated Terms from Term Extrs
Export Terms from Term Extraction File

Extract Bilingual Terminology from File...

Export Validated Terms from Term Extraction F

Save validated terms in a new
extraction file

as TB

as I"-'1uI1J

Save selected terms in a new

Export Validated Terms from Term Exira

extraction file

| ﬁahrava Bilingual Term Extractor 1. EC.IHrava‘.,tﬁt‘.,eurnpa rI".,da en".,eurnpar‘l da -2n.Csv

: File Options Plugins Help

The opened file is shown in the title bar.

30.07.2009 (c) 200

Mo I ‘SCOre = & Tems
25 1,00 32 1" 34 34 mondiale
T 1,00 20 22 20 20 est tout
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3-8 COptions Plugins Help
Cpen Term Extraction File. .. Ctrl + 0
Cloze File Ctrl +F4 ‘

Extract term pairs from
a TMX file

Sawve Term Extraction File. ..
Save All Terms into Term Extraction File...
Save Validated Terms into Term Extraction File. ..

Save Selected Terms into Term Extraction File... //]

——

Extract Bilingual Terminology from File...

Export Terms from Term Extraction File as TBX...
Export Validated Terms from Term Extraction File as TEX...
Export Terms from Term Extraction File as Multiterm. ..

l Export terms from open
‘ extraction file into TBX

Export Validated Terms, from Term Extraction File as I \ltterm... Format

Export Terms from Tery \Extraction File as Araya CV rmat...

Export Validated Term m Term Extraction File a a CVS Format. ..

II \\ // \\
Export validated Export terms from open Export validated terms
terms from open extraction file into from open extraction file
extraction file into Multiterm Format into TBX Format
Multiterm Format

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 15
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! %

3-8 COptions Plugins Help
Cpen Term Extraction File. .. Ctrl + 0
Cloze File Ctrl +F4 .
Save Term Extraction File. .. Export entrl_es from
Save All Terms into Term Extraction File... open extraction file in
Save Validated Terms into Term Extraction File. .. Araya CSV Format

Save Selected Terms into Term Extraction File. ..

Extract Bilingual Terminology from File...
Export Terms from Term Extraction File as TBX...
Export Validated Terms from Term Extraction File as TEX...

Export Terms from Term Extraction File as Multiterm. ..

Export Validated Terms from Term Extraction File as Multiterm... Export validated entries
Export Terms from Term Extraction File as Araya CVS Format... ; ;
from open extraction file

Export Validated Terms from Term Extraction File as Araya CVS Format... -
_ In Araya CSV Format
Exit Alt +%

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 16
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Extract terms from file E|

Extraction File

Source File Ciharayaltestidemo, b Browse, ., |

Extraction File 1C:harayaitestidemo. b, csy Source |anguage Target |anguage

Extraction File Properties 7{

Source Language ||:|e German (Skandard) + | Target Language |EI‘| English ﬂ

Minirnarn words |1 j Mazimurn words |3 ﬂ

Minimum Freguency |3 j Mazdimum Fregquency |1IIIIII j

Mazxirnurn branslations |3 j | Lower case source terms | Lower case barget berms

W Open after extraction % Open after extraction

Validated Terminology bo ignore

Terminology File JC:\arayaitestdemno-valid.tmx, csv Browse, ..
Extract kerms Close |

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH
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it

Minimum / Maximum words

Controls how many words should be contained min/max in
the found term pair

Minimum / Maximum frequency

Controls how often the term should appear min/max for the
found term pair

Maximum Translations

Controls how many translation should be found at
maximum

Source/Target terms in lower case

Controls if source and/or target terms should be converted
to lower case

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 18
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Validated terminology to ignore

If a terminology extraction file is specified here, all
terms which are marked as “validated” will be

ignored.
Thru this know translations are ignored.

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 19
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Exporting can be done in different formats.
TBX
Name of extraction file + ,.tbx"

Multiterm (™ of Trados/SDL International)
Name of extraction file + ,.multiterm*
Araya CSV
Name of extraction file + ,araya.csv*
Character encoding is always UTF-8
Either all or only the validated entries can be exported

In addition the selection filter (Options -> Export Score Filter)
controls the exported terms

Depending on chosen value only the term pairs with a minimum
score get exported (e.g. score higher than 0.6).

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH
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Araya CSV Format contains the languages In
the first line followed by the extracted terms

Beispiel

| Languages separated by ;
de;en —

Anschlussplan;Connection diagram

DIN;DIN
Dr;Dr k

Extracted terms separated by ;

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 21
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# Character set for the
extraction table
]
Plugins Help
1 Select Font = I —

Export Score Filter (0.0)

Filter Term Entries from Term Extraction File. ..
Filter Approved Term Entries from Term Extraction File. .. ==, Settings for
Search Terms ==0,7 minimum quality
Advanced Find/Select. .. ==0.6 for the export of
Deselect All Terms ==10.5 term pairs
Select Terms from UTF-8 Word File... All Terms

v English

\ 21
User Interface 27
Language

German

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 22
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/

Remove all term entries from the

term table contained in term
extraction file

Remove all term entries from the

term table contained in term
extraction file which are

approved

Search Terms in the extraction
table

Complex search for based on
source and target term

T

Deselects all selected in the
extraction table

Plugins Help

Select Font

Export Score Filter (0.0) /

Filter Term Entries from Term Extraction File...

Filter Approved Term Entries from Term Extraction File... n

Search Terms ]

Advanced Find/Select. .. E—

Deselect All Terms \

Select Terms from UTF-8\Word Filgs ]
v English

German

Select Terms based on a word
list in a file
30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH
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The filter functions filters all those term
entries which are contained in another term
extraction file.

The identical terms are removed from the
term table.

Depending on the chosen filter method the
approved or all entries are used from the
specified term extraction file.

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 24
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Search/Select Extracted Terms X|

Find l-:-u rism

Find | Find next

Select All Terms

Cancel | Close

AN

s

Search this term and select all the matching entries in the table.
The selected term candidates can then be saved with “File ->
Save Selected Terms into Extraction File...”

Find the next matching term

Start searching this term

30.07.2009

(c) 2006, 2007, Heartsome Europe GmbH 25
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| Search/Select Advanced Extracted

Source Term Itc-u rnsm

Target Term |T-:-u nsmus

LEVELE 5

Use regular expressions for

searching term entries

- I Use Regulare Expressions

Find nextl Select.ﬁ.JITermsl Can::ell Close

) \>

Search this term and select all the matching entries in the table.
The selected term candidates can then be saved with “File ->
Save Selected Terms into Extraction File...”

Find the next matching terms

Start searching these combination of
source and target terms

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 26
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()

The filter functions selects all the matching terms from an
UTF-8 encoded file. The filter search the given string in both
source and target language string

It also matches substrings

The selected term candidates can then be saved with “File ->
Save Selected Terms into Extraction File...”

Each word (string) in the file must be written on a single line.

B Lister - [c\araya\test\europarl -0 x|
Datei Bearbeiten Optionen Hife 100 %6
model
national
treatment

A I

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 27
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Convert Files between Character Encodings

Split TMX Files

Show Log File k

4 Conversion between
character sets

Check TMX File Languages
\N

Check and recode
Merge TMX Files \\‘ languages in TMX files
Count TMX TU Entries ]

Count TU and TUV entries
in TMX file

—

Split TMX files in several
TMX file

Merge several TMX files in

one TMX file

Display of

Araya Log-
File

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH

28



_ Heartsome Europe GmbH
EnTH www.heartsome.de

o

m ‘ Display user manual
User manual F1 B
4’////;,/,,////J Araya / Heartsome
Araya Homepage Homepage

about, .,
i — About the bilingual

extraction

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH
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Basic information about the
Araya configuration is shown
here.

This can be important for
error diagnosis

Using ,Save...“ the
information is stored in the
specified file.

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 30
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Source file name

Target file; will be created based
on source file name and as

extension the target encoding
\ character set
\‘ Source encoding character set

Target encoding character set

This function supports converting files between different character sets. Depending on the target character
up to two files are written. If the target file is a UTF-8, 16, 32 or UCS file, two files are written. The second file
with the extension ,.nobom * is a copy of the first target file, the only difference is that the BOM (Byte Order
Marks) are removed from this file. This file should be used for importing, esp. when an import of an UTF-8
file is done in Araya, as the Java reading functions for UTF-8 does not over read the BOM characters. This
could lead to problems when reading normal strings from those file as the BOMs are read as normal
characters resulting in invalid entries.

(This is a known bug in Java UTF-8 file reading, but will not be corrected by SUN!).

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 31
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TMX file name

Consists of tmx file
name, any “.tmx”
extension removed and
“recoded.tmx” added

%TMX file name;

Light yellow lines
indicate language
codes not supported

Language codes
supported by Araya
Combo box appears

Green lines
indicate language

codes supported by Araya only in case language
by Araya codes in TMX file not
supported by Araya
Start checking Recode languages
languages using new language for
contained in TMX the specified TMX File
File language

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 32
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TMX file name

Buttons to increase /
decrease number of tmx
files to create

Number of TMX files to
create from the given
tmx file

g

Start splitting Close Window

The created tmx files are composed of the original tmx file name plus a number from 1
till the number of chosen tmx file

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 33
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Add a file to the file list

Choose new TMX file name

List of chosen files

Remove a file from the file list

Start merging

30.07.2009

Close Window

(c) 2006, 2007, Heartsome Europe GmbH
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Start counting

/ Choose TMX file to analyse

Result:
First line: Number of TUs and TUVs
Following lines:
Number of language specific TUVs

30.0

7.2009

Close Window

(c) 2006, 2007, Heartsome Europe GmbH 35
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A set of predefined language codes Is
defined in the file ,ini/lancodes.txt”.

Additional language codes can be added by

mOdIfylng thIS flle Adding de-DE: This requires to add a line

like that — where = separates the name

I - displayed an the actual language code
Here is an example: | depeyedan e act

Galician=g|

German (Standard)=de
German(DE)=de-DE

‘ German (Austrian)=de-at
German (Liechtenstein)=de-li

German (Luxembourg)=de-lu

German (Standard)=de
German (Swiss)=de-ch

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH 36
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Heartsome Europe GmbH
Friedrichstr. 17
D-90574 Rol3tal

Email: info@heartsome.de
www.heartsome.de
© 2007, 2009 Heartsome Europe GmbH

30.07.2009 (c) 2006, 2007, Heartsome Europe GmbH

37



